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About this Manual 
 

This manual is intended for the personnel in the PAOs/CDDOs (similar entities in other accounting 
formations) who shall be uploading the Subscriber contribution information to NPSCAN. This manual is 
an abridged version of the Standard Operating Procedures (SOP) on Contribution Upload. For detailed 
information, the PAOs/CDDOs may refer to the SOP. 

 

Introduction: 
 

Under New Pension System, the monthly pension contributions of the Subscribers will be invested in 
various schemes of different Fund Mangers appointed by PFRDA as per the Subscriber‟s scheme 

preference. For this purpose, the monthly contribution details of the subscribers registered in the CRA 
system shall be uploaded to NPSCAN (www.npscan-cra.co.in.) by PAO/CDDO and the amount of 

contribution shall be deposited at the Trustee Bank. PAO/CDDO will prepare Subscribers‟ Contribution 

File (SCF) and upload it to NPSCAN system using the I-Pin allotted by CRA. The Subscriber Contribution 
File will contain details such as DDO Reg. No. of the Subscriber, PRAN of the Subscriber, month of 

contribution, amount of the Subscriber contribution, amount of Government contribution etc. 
 

 

Steps in preparation and upload of Subscribers Contribution File (SCF) by PAO/ CDDO 
 

I. Preparation of SCF using File Preparation Utility (FPU). 
 

II. Validation of the SCF using File Validation Utility (FVU). 
 

III. Uploading SCF to the NPSCAN System using I-Pin allotted to the PAO/CDDO. 

 
 

The steps are explained in the following diagram: 

 

 

 Subscriber Contribution File (SCF) Upload by PAO/CDDO  

Consolidation of 
FPU FVU   

Digitisation Validation Upload to 
 

DDO wise 

CRA 
Subscriber of Records of Records NPSCAN  

Contribution     

Records      
 

 

 

 

FPU -A utility provided by CRA that will assist in preparation of SCF as per the file 

formats of CRA. 

 

FVU- A Utility provided by CRA that will verify whether the SCF prepared is as per the file format 

of CRA 

http://www.npscan-cra.co.in/
http://www.npscan-cra.co.in/
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Installation of FPU & FVU 

 

PAO/CDDO user shall access the CRA website www.npscra.nsdl.co.in or www.nsdl.co.in and 
download the FPU and FVU and save it on the local machine.   
 

    After downloading, on navigating to the folder where the FPU/FVU is saved, a “.JAR” 
file will be displayed to the PAO/CDDO user. User will have to double click on the 
“FPU.JAR” / “FVU.JAR” file to open it. 

 
 

    Minimum hardware and software requirement for the utilities are given below: 

  
 

Software Minimum Requirement 
  

Browser Internet Explorer 6.0 and above 
  

Java Run Time Environment JRE 1.5 
  

Operating Systems Windows 2000 Professional / Windows XP 
   

 

 

Hardware Minimum Requirement 

  

Processor Intel Pentium PV / Celeron (333 MHz or Higher CPU). 
  

Memory Minimum 256 MB RAM. 
  

 

 

 

 

 

 

 

 

 

 

I. Preparation of SCF using FPU 
 

 The PAO/CDDO will consolidate the monthly details of the Subscriber’s pension 
contributions from various DDOs associated with it and digitise the records using the 
latest version of FPU. 
 

 PAO/CDDO should ensure that the latest version of FPU is being used. PAO/CDDO can 
get the latest updates in FPU and FVU from the CRA website, i.e., www.nsdl.co.in or 
www.npscra.nsdl.co.in. 

 

The FPU consists of two panels – 
 

A) PAO & Contribution File Details Panel 
 

http://www.npscra.nsdl.co.in/
http://www.nsdl.co.in/
http://www.nsdl.co.in/
http://www.npscra.nsdl.co.in/
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B) Subscriber Details panel: 
 

A. PAO & Contribution File Details: 
 

User will have to enter the following details in this panel:- 
 

• The fields which are marked with „*‟ are mandatory fields. 
 

• Type of Contribution File (Original / Correction): Where PAO/CDDO is preparing a 
new Subscriber Contribution file for a particular month for uploading to NPSCAN; the 
file type to be selected should be „Original‟. If PAO/CDDO wants to make any correction 
in a Subscriber Contribution file which has already been uploaded successfully and for 
which Transaction id has been generated by CRA, the file type should be selected as 
„Correction‟. Where file type is Correction, the  

o PAO/CDDO User will have to provide the transaction id of the original file. 
 

• PAO Reg. No.: Enter the PAO Reg. No. allotted by CRA 
 

• Name of PAO (Optional field): User can enter the Name of PAO in this field. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

B. Subscriber Details 

             

           User will have to enter the following details in this panel: 

 

 

• DO Reg. No.: User should enter the DDO Reg. No. allotted by CRA. 
 

• PRAN: User should enter PRAN of the Subscriber for which contribution details 
are being entered. 

 

• Subscriber’s Name: User may enter Name of the subscriber. This is an optional 
field. 

 

• Government Contribution: User should enter Government Contribution Amount. 
 

• Subscriber Contribution: This field is for entering Subscriber’s Contribution 
which is deducted from Subscribers salary. If Government Contribution amount 
is entered, this field will be automatically populated with the amount entered in 
the Government Contribution cell. 

 
• Pay Month: User can select the month of contribution from the drop down option 

available. 
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• Pay Year: User can select the year of contribution from the drop down option 

available. 
 

• Contribution Type: User can select the Contribution Type i.e. „Regular‟ or 
„Arrears‟ from the drop down option available. 

 
• Remark: Remarks column is mandatory only if the type of file is an arrear file. 

PAO user shall enter the period for which the arrears are pertaining to. 

 
 

 
For each month and for each type of contribution (regular contribution record and arrear contribution 
record), there will be one record for each subscriber. 
 

PAO/CDDO user can enter the subscriber details manually or copy the data from an excel sheet. 

To paste data from an excel sheet, PAO/CDDO user can use “Paste from Excel” option. This 
can be done either by going to the Edit Menu and using the “Paste from excel” option or by 

right clicking the mouse. 
 

PAO/CDDO user can add or delete the required rows by selecting the Add Rows and Delete 

Row button provided at the bottom of the screen. 
 

 

Creation of SCF: After complete digitisation of necessary details, the user can create the 
Subscriber Contribution File by selecting Create File button. 
 

 FPU will create an output file having extension ‘.txt’. 
 

 A unique batch id will be generated on successful generation of a file 
 

 The above-mentioned „.txt‟ file will be taken forward for further processing. 
 

 If the FPU encounters any error in the data entered by the user, such as, mandatory 
fields not entered, PAO/CDDO reg. no., PRAN structurally invalid, remarks not 
provided (when the type of record is „Arrear‟), month of contribution entered 
twice for a particular subscriber etc., it will display an error message to the user. 
In all such cases, FPU will not generate any output file. The user will be required 
to rectify the errors and create a valid file again.

 

 

  
Preparation of Intermediate File 

 
 PAO/CDDO user will have the option to save the data at any point in a file while digitising 

the details. This saved file will be an intermediate file. User can save the partially filled 
details by clicking the Save option in File menu. 

 
 

 The user can reopen the intermediate file with the same version of FPU in order to modify 
the existing data. The User can use this file to prepare SCF for the future months as well, 
by modifying the respective fields such as month and year of contribution etc. To open 
the intermediate file, user has to select the “Open” option in the File menu. 
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II. Validation of SCF using FVU: 
 

 After the completion of preparation of the Subscribers Contribution File using FPU, 
PAO/CDDO will validate the output file of FPU with a File Validation Utility (FVU). 

 
 The User will double click on the FVU.JAR icon at the path where FVU is installed to 

open it. 
 

 The user, while processing the file in FVU, will select the name (with the ‘.txt’ extension 
as mentioned in 4.3 above) of the input file to be passed through FVU for validation. 

 
 The Input file name should not contain any special characters e.g. :, \ / etc and should not 

exceed 12 characters. 
 

 User will also specify the path where either an ‘error file’ or ‘Control Sheet’ is to be 
generated and saved by the FVU on successful completion of validation of the file. 

 
 It is mandatory for the User to fill both ‘Input File Name with Path’ and Error/Upload 

File Path’. Validate button will remain disabled till both fields are not entered properly. 
 

 The user will validate the file by selecting the “Validate” option in the FVU. 
 

 If the file is successfully validated, FVU will create the upload file with extension ‘.fvu’. FVU 

will also create a control sheet (an HTML report) in the path specified in the ‘Error/Upload 

File Path’ (as mentioned above). 
 

 If the FVU encounters/detects any errors during validation process, the utility will display 
an error message and generate an “.html” file showing a list of errors associated with that 
particular file. 

 
 Subscriber contribution file (with „.FVU‟ extension) is ready for upload in NPSCAN 

after it has been successfully passed through FVU. 
 

 

III. Upload of SCF to NPSCAN 
 

 After validating the Subscribers Contribution File through FVU, PAO/CDDO will upload 

the output file having ‘.fvu’ extension to NPSCAN (web based facility). PAO/CDDO will 

upload the file using the I-Pin allotted by the CRA to the PAO/CDDO at the time of 

registration.
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 PAO/CDDO user will have to log-in to NPSCAN using its I-Pin and password. For this, 
the PAO/CDDO user will have to log in to www.npscan-cra.co.in . 

 
 After PAO/CDDO user successfully logs in, user can click on ‘Upload Contribution File’ 

option. For this purpose, user will select the files with ‘.fvu’ extension and clicks on add 
files button. Once the desired file/s is/are selected, user will click on 'Upload All' option. 
Only files with ‘.fvu’ extension can be uploaded. User can select multiple files with help 
of “Ctrl” key. 

 
 If  upload  of  file(s)  is  successful;  NPSCAN  will  display  the  status  of  the  file  as  
 ‘Uploaded in NPSCAN’ and will generate a unique File Reference Number (FRN) which 

will be displayed to the User. User may note the FRN for record purpose. User can use 
this FRN for viewing the status of the file at a later stage. 

 
 After successful upload, NPSCAN system will perform certain business level validations 

in addition to the validation performed by “FPU” and “FVU”. 
 

 If the all the validations are successful, NPSCAN will update the status of the file as  
 “Accepted” and will generate a unique 13 digit Transaction id. 

 
 The system will also generate a receipt ‘Contribution Submission Form’ (CSF). 

 

Viewing the status of the files uploaded: 
 

In order to view the status of the uploaded file, the user will have to navigate the “Contribution 

Details” menu and select the “File Status View” option. After selecting the “File Status View” 
option, the user will have to enter any one of the following search criteria ‟s as mentioned below: 
 
• File Reference Number

 
 

• Batch Id
 

 

• Transaction Id
 

 

• From Date & To date.
 

 

 

Along with Transaction id, NPSCAN will also generate the Contribution Submission Form 

(CSF). PAO/CDDO shall download and print the Contribution Submission Form. The 

Contribution Submission Form will contain PAO Reg. No., PAO address, contribution month, 

transaction id, amount to be deposited in the bank etc and a counterfoil for Trustee Bank to issue 

acknowledgement to PAO/CDDO. This form is to be submitted by the PAO/CDDO to the Trustee 

Bank while depositing the contribution amount. 
 

If the file validation is not successful due to reasons such as invalid PRAN, invalid FPU version, 
invalid PAO-DDO mapping etc, NPSCAN will reject the file (status of the file will be updated 
to “Rejected”) and will generate an error file which will be available for download. 
 

Correction file: 
 

 PAO/CDDO will have an option to upload the correction file by mentioning the transaction 
id of the original file in case the earlier file uploaded at NPSCAN is incorrect, contains any 
wrong data or is in match failed status. NPSCAN provides a PAO/CDDO a facility to upload 
a correction file for any previously uploaded file which has been accepted by NPSCAN and 
CRA system and for which Transaction id has been issued by NPSCAN. 

http://www.npscan-cra.co.in/
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 For preparing the correction file, the User has to first select the type of contribution upload 
as “Correction” and mention the transaction id in the field provided. The User should note 
that the transaction id is mandatory in case type of upload is correction. The correction file is 
to be prepared and validated on the same lines as a regular file. 

 

Transfer of funds to Trustee Bank : Nodal office can transfer the funds to the 

Trustee Bank through the following modes: 
 

 Cheque /DD transfer – cheque/DD to be submitted to the branch of the Trustee Bank 
along with the Contribution Submission Form (CSF). The relevant blank fields to be filled 
by PAO/CDDO. Amount deposited should be exactly equal to the amount mentioned in 
the CSF. Counterfoil of the CSF given by the Trustee Bank as an acknowledgement 
should be maintained for record purpose. The details of the branches of Trustee Bank are 
available in our website –www.npscra.nsdl.co.in. 

 
 Electronic transfer (RTGS/NEFT) – instructions to be given to the bank of the Nodal 

office to transfer the funds to the Trustee Bank. In the RTGS/NEFT application, the Nodal 
office has to mention the following details: 

 

City, Bank, Branch, PAO name, account type , Account Name & Number. In case of electronic 
Fund Transfer PAO Regn number and Transaction id/ super Transaction id have to be mentioned 

as „PAOFIN<Regn no.><Tran id>‟ in Field 7495 (Sender to receiver information, line No.4) of 
RTGS Message or in Field 7002 (Origination of remittance) of NEFT Message. 
 

Trustee Bank will not be in a position to upload the fund receipt details to the CRA system and 
the funds will lie idle with the Trustee Bank. PAO/CDDO should track the status of SCF uploaded 

and follow up with the Trustee Bank if the payment details are not reflecting in the CRA system. 
 

Tracking the status of Contribution amount transferred; 
 

 Matched & Booked – The SCF uploaded by the PAO/CDDO and the fund receipt 

confirmation uploaded by the Trustee Bank matches and the Matching & Booking Process 

is successfully completed i.e., pension contribution fund has been allotted for investment. 
 
 

 Match Failed – The SCF uploaded by the PAO/CDDO and fund receipt confirmation 
uploaded by the Trustee Bank do not match. PAO/CDDO has to find out the reasons and 
take necessary action. . 

 

In case fund confirmation file is not uploaded by Trustee Bank within T+3 days (T being the day 

of upload to NPSCAN), an email alert will be sent to PAO/CDDO from the CRA system. On 
receipt of the alert, PAO/CDDO shall contact the Trustee Bank for upload of the fund 

confirmation file. 
 

Preparation of file for the subsequent months : 
 

1) While preparing SCF for the next month, PAO/CDDO User can use the earlier SCF and 
make the necessary changes such as pay month etc. PAO/CDDO should consider the 
following illustrative list for changes before preparing the SCF. 

 
i. Promotion 

 
ii. Increments to any of the Subscribers 
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iii. Arrears to any / all of the Subscribers 

 



 

 

Subscriber Contribution File Upload 
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iv. Leave without pay 
 

v. New Subscriber joining 
 

vi. Transfer in of an existing Subscriber from another PAO/CDDO 
 

vii. Retirement /Transfer out of an existing subscriber to another PAO/CDDO 
 

viii. Resignation of a Subscriber 
 
2) In case there are no changes as mentioned above, the PAO/CDDO User shall re-open the SCF 

prepared for the earlier month and modify only the details of Month and year and save the 

intermediate file and the “.FPU” with a different name. In case of any of the above mentioned 

scenarios happening, the PAO/CDDO User will have to incorporate the effects / 

modifications in the SCF. The modifications that resulted from those scenarios are as follows: 
 

i. In case of arrears, the PAO/CDDO User will have to mention the remarks in the 

“Remarks” column and select the type of file as Arrears. 
 

ii. In case of promotions / increments/ leave without pay, the PAO/CDDO User will have to 
modify the amount in the Subscribers and Government Contribution columns. 

 
iii. In case of transfer-in/transfer-out cases, the PAO/CDDO User should add/delete all the 

details of the concerned employee in the existing file and update the file. 
 
iv. In case of retirements / resignations, the PAO/CDDO User has to ensure that all the details 

of the retired employees have been deleted. 

 

SUMMARY OF ACTIVITIES 
 

 

1) Consolidation of DDO wise contribution details in case of PAO and consolidation of 
subscriber-wise contribution details in case of CDDO. 

 
2) Preparation of file using latest version of FPU. 
 
3) Validation of the file through latest version of FVU. 
 
4) Upload of the validated file to NPSCAN system. 
 
5) Printing of contribution submission form. 
 
6) Deposit of contribution amount with the Contribution submission form at the Trustee Bank. 
 
7) Track the status of files uploaded in NPSCAN. 
 
8) Upload correction files, in case the files are rejected at NPSCAN or the files are in Match 

Failed status. 
 

9) Co-ordination with Trustee Bank in case the FRC is not uploaded with in three days of 
submission of CSF on receipt of alert from CRA system. 
 

 
 

********************** 


